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RESys is an integrated software system for performing oil and gas reservoir evaluations. 
Based on an integrated database and using object oriented software design techniques, 

RESys is a modular and extensible software system consisting of various specialized 
modules for the analysis and evaluation of well logs, core data, production data and more. 

The modular integrated design allows the system to be extensible, so that additional modules 
can be added without requiring a rewrite or redesign of the rest of the system. In addition, due 

to the modularity and integrated database, individual modules can be optimized. 

RESys is designed as a standalone, yet integrated system. Each module can be used by 
itself; however the full power of integrated software is unleashed when the various modules 
are combined.  

RECores comprises the module allowing the sedimentological description of well cores and 
outcrops. As a standalone program, it allows the description and organization of 
sedimentological descriptions and interpretations, but RECores is fully integrated with the 
petrophysics related modules in RESys, so the sedimentological interpretations are available 
for use in an integrated petrophysical description of a reservoir or field. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

At Comport Computing we value the comments and suggestions of our software users. If you 
find a bug, please let us know. We'll fix it as fast as possible and send you a free updated 
copy of the software. In addition, if you suggest an enhancement which we implement, you'll 
receive a free upgrade to the new version. 

 

Corrections or comments on RESys, RECores or this manual should be directed to “software@comportco.com”.  

mailto:software@comportco.com
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Overview 

 

RECores is a system for entering, saving and displaying sedimentological data and 
interpretations of well cores and outcrops. The system consists of a database along with tools 
to aid in the entry of data and interpretations. RESys is based on so-called “projects” which 
represent data that are somehow related. You can create as many projects as you want and 
organize them in whatever way makes sense for your purpose. For example, for oil field 
cores, perhaps a project would consist of all of the cores in a given oil field. On the other 
hand, for a student, a project might be all of the descriptions done during a class or in 
conjunction with a project. It really is up to you as to how you want to organize your projects 
and data. 

It is important to understand that the project database contains all of the information needed 
to make or view a core or outcrop description, including standard symbols. If you need to 
make a backup of the project, simply copy the project database. You do not need to load 
standard symbols for each well or description. Instead all of the symbols that you use in a 
description are saved in the database. 

When creating a project, the project initially has no standard symbols defined. As a user you 
have 2 options: 1) create the symbols you need individually, or 2) load a set of saved symbols 
from an external file. Either way, all of the symbols either loaded or created will be saved in 
the project file and will be available for use in any descriptions for any wells or outcrops 
included in the project. 

Once a project is created or opened, the leftmost side of the RECores main window shows 
the list of wells and outcrops included in the project. To the right of the wells and outcrops a 
list of cores and a list of log curves is shown. At the top of the window there are various 
menus and tool bar buttons as shown in the screen shot below.  
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Selecting any well in the list will update the core and curve lists to show the cores and log 
curves available for that well. For outcrop descriptions, there may be nothing shown. 

The menu at the top of the window allows access to the functions available in RECores and 
includes functions to create and open projects, display sedimentological descriptions, etc. 

The Toolbar contains buttons for rapid access to sedimentological description functions, such 
as viewing the descriptions, and adding lithology, facies, sedimentary structures, fossils, etc.  

A sedimentological description can be displayed by selecting a well/outcrop and clicking the 

display button . The description display is controlled by templates which can be configured 
as desired. Although a simple default template is built in, in most cases, due to differences in 
names and user preferences, it will be preferable to redefine the templates to display the 
descriptions as desired. The ability to edit, save and load templates is provided interactively 
from the display window. 

Note that there is no limit to number of templates that can be defined, nor is there a software 
limit to the number of descriptions that may be simultaneously displayed, the size of the 
display or the number of curves and tracks displayed. Instead, the limitations will mainly be 
determined by the screen size. 

The Project menu contains functions to create, open and close projects, and edit project 
information. It also allows sedimentological symbols and patterns to be defined, loaded from 
an external file and saved to an external file. 

The Description menu contains functions to create wells and outcrops, display the 
description graphically and add, delete or modify the description. Most of the items in the 
Description menu are also available from the Toolbar buttons. 

The Tools menu provides the option to automatically load the last project when RECores is 
started. 

The Language menu allows the use of either English or Spanish text on all of the windows in 
RECores. To change the language, simply select the desired language from the menu. 

The Help menu allows information concerning the version of RECores to be displayed. To 
see the version information, select Help | About. 
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Getting Started 

 

To start using RECores, it is necessary to open or define a project. Defining a project creates 
a database which will contain all of the data needed to view and evaluate well logs as well as 
cores or outcrops. It should be noted that RESys uses a Microsoft Jet database by default. 
That means that there's nothing special to install or configure, since Jet drivers are normally 
included in Microsoft Windows. It’s the same database format used by Microsoft Access. 
Once any RESys module, including RECores, is installed, it is ready to use without any 
further hassles, unless you decide to use a different database format. The remainder of this 
manual assumes that the default Jet database is used. 

 

Creating a Project 

To create a new project, select Project | New from the menu. You will need to select a 
directory and a filename from the file selection dialog, and then will be asked if you want to 
create the project. Selecting Yes will automatically create the database, selecting No will 
abort with no database created. If the selected file already exists, you will be asked whether 
to replace the database. Selecting Yes will overwrite the existing file, erasing all of its 
contents. Selecting No will abort without doing anything. 

Once the project database is created, you will be presented with a dialog to enter the project 
name as shown. Simply add your own project title. Click Ok to save the project data or 
Cancel to accept the default. Normally you will want to provide your own name for the project. 
If you need to change the project name later, simply select Project | Edit from the menu. 

 

 

 

Once the project has been created, it will be opened for use.  

 

Opening an Existing Project 

If you have an existing RESys project, you can open it for use by any module, including PT. 
Simply select Project | Open from the menu and then choose the project database file from 
the file selection dialog. 
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When a Project is Opened the First Time 

The first time a module is used with a particular project, the RESys system will check to make 
sure that all needed parameters and units are defined and you will be presented with a dialog 
allowing the units to be defined. (Note that RECores does not need any special parameters.) 
Depending on what modules may have been used before, you may see some or all of the 
following unit definitions. To accept the defaults, simply press Ok. To change the default 
units, select or type the desired unit name in the Unit column and a conversion factor in the 
Factor column. For example, to specify depth in meters, use m as the unit name and 3.28084 
(the number of feet in a meter) as the factor. 

Note that once set, these values and units definitions cannot be changed, since doing so 
would corrupt the database. 

 

 

 

Other modules of RESys may also require Parameters to be defined, but no special 
parameters are required for RECores. 

 

Standard Symbols 

RECores supports complete flexibility in symbols and patterns for sedimentary structures, 
fossils, lithologies and facies. When starting a new project, you probably don't want to create 
all the symbols and graphics patterns required during the description, so you can load a set of 
default symbols from a file. RECores comes with standard symbols for sandstone and 
carbonate descriptions. You can change the name and graphics for any symbol or pattern or 
add additional symbols and patterns to the project from the Project | Create/Edit Symbols 
menu.  
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To import a set of standard sedimentary symbols, choose Project | Import Symbols from the 
menu. You will see a file open dialog allowing you to choose a symbol file (*.xml). Select the 
desired file and select OK to load the predefined symbols and patterns into your new project. 
Please note that loading symbols twice will create a duplicate set. In general, you 
should only load symbols once for any project. 

If you find that you need to use different symbols than provided by default with RECores, you 
can easily create and define your own symbol sets and patterns. To save the currently 
defined symbols and patterns to a file, choose Project | Export Symbols from the menu and 
then select the file to save the symbols into. When you create a new project in the future, you 
can load that file as your default symbol and pattern set. 
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Creating a Well or Outcrop 

Of course a project isn't of much use without data, so normally the next step will be to create 
a well or outcrop to be described. Simply select Description | Wells/Outcrops | New from 
the menu and give your well or outcrop a name. If you need to change the information later, 
simply select Description | Wells/Outcrops | Edit from the menu. 

 

 

 

Note that the well must be given a unique name. The other data is optional, but if entered 
here, they will be available in other RESys modules.  

Note also that RECores can be used for outcrop descriptions as well as cores. If the 
description is for an outcrop, check the Outcrop box so that depths will be interpreted as 
heights in the description. 

Adding Descriptions 

To add sedimentological descriptions to your well core or outcrop, select the desired button 
from the Toolbar or from the Description menu on the main window or the respective button 
on the display window. Adding descriptions can be done interactively by opening a category 
(Cores, Stratigraphy, Text, Structures, Facies, etc.) The windows used to enter or edit the 
various types of data are shown below.  

As you add or edit the information, you can press Apply to commit the changes and then 
press Refresh on the display window to see the changes. It should be noted that when you 



 

RECores User's Manual Page 7 

 

press Apply, the changes are not saved to the database. To commit the changes to the 
database, press the Ok button, which will save the information and close the window. 
Pressing the Cancel button will throw away all the changes and revert to the information 
already saved in the database. 
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Displaying a Description 

To view a description, simply select the well or outcrop in the list and click the description 

display button . The graphical description for the selected well or outcrop will be displayed 
using the current template, which can be modified and redefined as desired.  
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The first time you display a description, a standard template will be used that displays normal 
data in black and white in a standard layout. Normally much better displays are possible by 
modifying the template and saving it in a new file. You may edit the display configuration 
interactively and then save the template to a file and load a template from the Template 
menu in the Display window. A typical customized display is shown above. 

On the display, the number and order of tracks can be defined, along with the scale, colors 
and display options for each type of track. As detailed later in this manual, RECores supports 
9 types of tracks for display purposes.  

On the display, a depth interval can be selected with the mouse for zooming when the mouse 
cursor displays as cross-hairs, which is the default mouse mode. To select “Zoom” mode, 

press the Mouse Zooms button . The Zoom Reset button  will reset the display to the 
default depth interval. It is also possible to type the top depth and depth interval into the fields 
at the top of the display to show a portion of the log. The displayed depth section can also be 
selected by moving the slider on the right side of the window. Major and minor depth grid 
marks can be displayed or hidden by selecting the respective options on the Configure menu 
item. 

The symbols legend can also be displayed by pressing the “Show Legend” button. 

 

 

 

Display Templates 

The sedimentological displays in RECores are controlled by templates, which the user 
configures interactively. Please note that the user never really needs to see the templates, 
since the results are always visible on the display. On the Display screen, each Track is 
separated by a gray line which can be moved by the user with the mouse. When the mouse 
cursor is over a track separator, the cursor will change to 2 parallel lines with arrows. To 
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change the width of a Track, simply place the mouse on the gray space between tracks and 
move the track width to the right or left as desired while pressing the left mouse button.  

The font used on the display can also be changed by selecting Configure | Font from the 
menu, then selecting any available font type and size. Be aware that RECores uses standard 
Windows fonts, so if you choose a specialized font, the font information might not be available 
on other computers. If you have not installed any specialized fonts in Windows, there will not 
be any trouble transferring templates from one computer to another. 

Each display template consists of a number of “Tracks” or columns of information ordered by 
depth. A display template can contain any number of Tracks of any type. To modify the 
display configuration, it is necessary to select a track with the mouse. To put the mouse into 

track selection mode, press the Mouse Selects button . To select a track, simply press 
the left mouse button with the mouse cursor over the desired track. When selected, the 
background color of the track will change. 

To add additional tracks to the display, select Track | New | Insert to insert a track before the 
currently selected track or Track | New | At End to add a track at the right side of the display. 
To delete a Track, select Template | Delete Track and then select the track number to delete 
from the list presented. 

When you first run RECores or any other time a user defined template is not available or not 
specified, RECores automatically uses a default template. The means to load and save 
display templates are found in the Template menu on the Display screen. To load a 
previously saved template, select Template | Load from the menu and select the desired 
core template file (*.ctf) from the file dialog. To update the template currently in use, select 
Template | Save from the menu. If you are using the standard template, you will be required 
to enter a filename. To save the current configuration to a new template file, select Template 
| Save As and enter a filename on the file dialog. You can create as many templates as 
needed or desired. 

 

Display Track Types 

RECores has 9 different types of tracks that can be displayed in any order. Once a track has 
been added, you can change the type of track and the options by selecting the track and 
choosing the desired track type from the Track | Type menu. Each track type has additional 
configuration options accessible from the menu. 

 

Cores.  This track displays the location of the cores, core boxes and samples. Select the 
respective items on the submenu to display cores, core boxes and sample points. You may 
also choose the color for the cores and core boxes display. 

 

Depth.  This track shows the depth scale.  

 

Stratigraphy.  This displays the stratigraphic information. Select the submenu items to 
display Systems, Series, Stages, Formations, Members and Others as desired. The color 
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used to fill the respective areas can also be defined.  

 

Symbols.  This track displays the symbols used to indicate sedimentary structures and 
accessories, fossils, trends, bitumen and bioturbation.  

 

Grain Size.  This track displays the framework grain sizes. Select the submenu item to show 
or hide the grain size scale if desired. 

 

Lithology.  This track displays the lithology patterns.  

 

Facies.  This track will display the defined Facies, Associations, Environment and Systems 
tracts. Select from the submenu to determine which categories should be displayed. 

 

Curves.  The Curves track displays curves, usually imported from well logs in LAS format. 
The submenu allows a new curve to de added, whether the scale divisions should be shown 
and existing curves can be edited. 

To add a curve to a Curve track, select Track | Type | Curves | New. To change the 
appearance of an existing curve, select Track | Type | Curves | Edit <curve>, where 
<curve> is an existing curve name. On the resulting dialog, you can change the curve to be 
displayed, set the color for the curve, determine whether to show the curve or the points or 
both and also define the curve scale to be used. 

 

Importing Well Logs 

For comparison between petrophysical and sedimentological data, well logs in standard LAS 
format can be imported by selecting Description | Curves | Import LAS from the menu. You 
will need to select the LAS files to import from the file selection dialog, then press Open. Note 
that you can choose multiple files to rapidly import a number of well logs at once. 

During the LAS file import, any new wells found will be automatically added to the project and 
show up in both the well list and on the map. The curve list will also be updated, so that all of 
the curves will be immediately available for viewing and analysis. 

 

User Defined Symbols and Patterns 

Nearly all of the symbols and patterns used in RECores can be changed and replaced with 
other symbols if required.  

The lithology patterns and names are defined by selecting the Project | Edit Symbols | 
Lithology from the main menu. The displayed list of currently defined patterns will be shown. 
To change the lithology description, simply edit the text. The width column shows the relative 
size of the pattern as a fraction of the Lithology Track width, i.e. 0.5 will fill half of the track, 
1.0 will fill the entire track, etc. To change the pattern, select the corresponding cell in the 
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Pattern column and then choose a bitmap file containing the pattern to be used. Many 
patterns are available with RECores in the Images directory. To create your own patterns, 
simply use a graphics editor to define the pattern (i.e. MS Paint) and save the graphics file as 
a bitmap image (*.bmp). 

Facies and related colors are defined by selecting Project | Edit Symbols| Facies from the 
main menu. The display will show separate tabs for Facies, Association, Systems and Tracts. 
On each tab, you can change the description of any entry by editing the text. To change the 
color, simply select the corresponding cell in the Color column and select the color to be 
used. 

Sedimentological symbols, which include structures, accessories, fossils, bitumen, 
bioturbation trends and surfaces are defined by choosing Project | Edit Symbols | 
Sedimentary from the main menu. The description text can be edited, and the class of the 
symbol can be defined to determine which column it will ultimately be displayed in. To change 
the symbol graphic, select the corresponding cell in the Symbol Column and then select the 
bitmap file containing the symbol. Many symbols are available with RECores in the Images 
directory. To create your own symbols, simply use a graphics editor to define the symbol (i. e. 
MS Paint) and save the graphics file as a bitmap image. 

 

Symbol and Pattern Legend 

The symbol and pattern Legend can be displayed from the Display window by selecting Tools 
| Show Legend from the menu. Only those symbols and patterns actually used in the Display 
will be shown.  
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Printing 

RECores supports printing to standard Windows printers. To print a core description, press 

the Print button . A print preview screen will appear, showing how the description will look 
when printed. 

On the Print Preview screen, you can change the vertical scale and select whether to print the 
symbols legend. Press the Page Setup button to adjust the printer and page settings, Cancel 
to quit and Print to send the description display to the selected printer or plotter.  

 

 

 


